
 

 

 

ESTUDIO DE ACCESO AL FORO ROMANO 
DE SAGUNTO EN LA EDAD ANTIGUA A 

PARTIR DE MODELIZACIÓN 3D 
GRADO EN INGENIERÍA GEOMÁTICA Y TOPOGRAFÍA 

 

 

 

 

 

 

 

AUTOR: JOSÉ MARÍA LÓPEZ 

PÉREZ 

 TUTOR: ANA BELÉN ANQUELA JULIÁN 

COTUTOR: JESÚS MANUEL PALOMAR VÁZQUEZ 

Fecha: Septiembre 2020 

Curso: 2019 - 2020 



 

 

Página | 1 
 

"El presente documento ha sido realizado completamente por el firmante; no ha sido entregado 

como otro trabajo académico previo y todo el material tomado de otras fuentes ha sido 

convenientemente entrecomillado y citado su origen en el texto, así como referenciado en la 

bibliografía". 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Página | 2  
 

AGRADECIMINETOS 
Me gustaría dar las gracias a toda mi familia, padres y hermanos, por todo el apoyo que me han 

dado durante todos estos años y por haber estado a mi lado en los momentos complicados que 

hemos pasado. 

También, a mis compañeros que siempre han estado dispuestos a ayudarme cuando lo he 

necesitado y con los que he pasado muy buenos momentos alegres que nunca olvidaré. 

A todos los profesores, que no han cesado en empeño de enseñarnos todos los conocimientos 

necesarios para que salgamos lo mejor preparados posible al mundo laboral. 

Y, por supuesto, a mis tutores Ana Anquela y Jesús Palomar, por toda su paciencia, por todos 

los conocimientos que me han enseñado a lo largo de la carrera y por toda la ayuda que me han 

ofrecido para la realización del TFG. 

  



ESTUDIO DE ACCESO AL FORO ROMANO DE SAGUNTO EN LA EDAD ANTIGUA A PARTIR DE MODELIZACIÓN 3D 

   

Página | 3 
 

ÍNDICE DE CONTENIDOS  
AGRADECIMINETOS ..................................................................................................................... 2 

ÍNDICE DE CONTENIDOS ............................................................................................................... 3 

ÍNDICE DE ILUSTRACIONES ........................................................................................................... 5 

ÍNDICE DE TABLAS ........................................................................................................................ 7 

1.- INTRODUCCIÓN Y OBJETIVO DEL PROYECTO .......................................................................... 8 

2.- ¿QUÉ ES EL LIDAR? .................................................................................................................. 9 

3.- SOFWARE UTILIZADO ............................................................................................................ 11 

3.1.- LASTOOLS ....................................................................................................................... 11 

3.2.- FUSION ........................................................................................................................... 11 

3.3.- QGIS ............................................................................................................................... 12 

3.4.- SAGA .............................................................................................................................. 13 

3.5.- ARCGIS ........................................................................................................................... 13 

4.- DATOS DE PARTIDA ............................................................................................................... 15 

4.1.- Datos LIDAR .................................................................................................................... 15 

4.2.- Ortofoto de máxima calidad .......................................................................................... 16 

5.- METODOLOGÍA ..................................................................................................................... 17 

5.1.- LASZIP ............................................................................................................................. 17 

5.2.- FUSION ........................................................................................................................... 18 

5.3.1.- Mergedata ............................................................................................................... 20 

5.3.2.- Clipdata ................................................................................................................... 21 

5.3.3.- GroundFilter ............................................................................................................ 21 

5.3.4.- GridSurfaceCreate ................................................................................................... 23 

5.3.5.- DTM2ASCII .............................................................................................................. 24 

5.4.- QGIS ............................................................................................................................... 25 

5.4.1.- Mapa de pendientes ............................................................................................... 26 

5.4.2.- Ruta de menor coste ............................................................................................... 27 

5.5.- SAGA .............................................................................................................................. 28 

5.5.1.- Mapa de pendientes ............................................................................................... 29 

5.5.2.- Mapa de costes acumulados ................................................................................... 30 

5.5.3.- Ruta de menor coste ............................................................................................... 31 

5.6.- SAGA-QGIS ..................................................................................................................... 32 

5.6.1.- Mapa de pendientes ............................................................................................... 33 

5.6.2.- Mapa costes acumulados ........................................................................................ 34 



Página | 4  
 

5.6.3.- Ruta de menor coste ............................................................................................... 35 

5.7.- ARCGIS ........................................................................................................................... 37 

5.7.1.- Mapa de pendientes ............................................................................................... 38 

5.7.2.- Reclasificación de mapa de pendientes................................................................... 39 

5.7.3.- Rasterizar la capa vectorial de la zona de estudio ................................................... 41 

5.7.4.- Mapa de superposición ponderada ......................................................................... 43 

5.7.5.- Mapa de distancia de coste ..................................................................................... 44 

5.7.6.- Mapa de menor vínculo de coste ............................................................................ 45 

5.7.7.- Ruta de menor coste ............................................................................................... 47 

5.7.8.- Ruta de menor coste como polilínea ....................................................................... 48 

5.7.9.- ModelBuilder........................................................................................................... 50 

6.- RESULTADOS ......................................................................................................................... 51 

7.- PRESUPUESTO ....................................................................................................................... 55 

8.- CONCLUSIONES ..................................................................................................................... 59 

9.- BIBLIOGRAFÍA ........................................................................................................................ 61 

9.1.-CASTILLO DE SAGUNTO Y DEFINICIÓN DE LIDAR ............................................................. 61 

9.2.- DATOS DE PARTIDA ........................................................................................................ 61 

9.3.- LASTOOLS ....................................................................................................................... 61 

9.4.- FUSION ........................................................................................................................... 62 

9.5.- QGIS ............................................................................................................................... 62 

9.6.- SAGA .............................................................................................................................. 62 

9.7.- ARCMAP ......................................................................................................................... 62 

9.8.- PRESUPUESTO ................................................................................................................ 63 

9.9.- IMÁGENES ...................................................................................................................... 63 

10.- ANEJOS ................................................................................................................................ 64 

10.1.- CAPA VECTORIAL DE LA ZONA DE ESTUDIO ................................................................. 64 

10.2.- CARTOGRAFÍA .............................................................................................................. 66 

 

  



ESTUDIO DE ACCESO AL FORO ROMANO DE SAGUNTO EN LA EDAD ANTIGUA A PARTIR DE MODELIZACIÓN 3D 

   

Página | 5 
 

ÍNDICE DE ILUSTRACIONES 
Figura 1. Ortofoto del vuelo americano de 1956 de la zona de Sagunto ...................................... 8 

Figura 2. Componentes básicos de un sistema LIDAR .................................................................. 9 

Figura 3. Tipo de escaneo del terreno ........................................................................................ 10 

Figura 4. Logotipo de LAStools ................................................................................................... 11 

Figura 5. Espacio de trabajo de LASzip ....................................................................................... 11 

Figura 6. Logo de FUSION ........................................................................................................... 11 

Figura 7. Espacio de trabajo de PDQ .......................................................................................... 12 

Figura 8. Interfaz principal de FUSION ....................................................................................... 12 

Figura 9. Espacio de trabajo de QGIS ......................................................................................... 12 

Figura 10. Logo de QGIS ............................................................................................................. 12 

Figura 11. Espacio de trabajo de SAGA ....................................................................................... 13 

Figura 12. Logo de SAGA ............................................................................................................ 13 

Figura 13. Aplicaciones de ArcGIS .............................................................................................. 13 

Figura 14. Logo de ArcMAP ........................................................................................................ 14 

Figura 15. Vista de datos de ArcMAP ......................................................................................... 14 

Figura 16. Vista de composición de mapa de ArcMAP ............................................................... 14 

Figura 17. Página principal del CNIG .......................................................................................... 15 

Figura 18. Tipos de modelos digitales de elevaciones ................................................................ 15 

Figura 19. Archivos LIDAR de la zona de Sagunto ....................................................................... 15 

Figura 20. Página principal del CNIG .......................................................................................... 16 

Figura 21. Tipos de ortofotos e imágenes de satélite ................................................................. 16 

Figura 22. Ortofotos de la zona de Sagunto ............................................................................... 16 

Figura 23. Diagrama de flujo ...................................................................................................... 17 

Figura 24. Espacio de trabajo de LASZIP ..................................................................................... 17 

Figura 25.  Algoritmo de trabajo de LASZIP para la hoja 732-4396 LIDAR .................................. 17 

Figura 26. Algoritmo de trabajo de LASZIP para la hoja 732-4398 LIDAR ................................... 18 

Figura 27. Algoritmo de trabajo de LASZIP para la hoja 734-4396 LIDAR ................................... 18 

Figura 28. Algoritmo de trabajo de LASZIP para la hoja 734-4398 LIDAR ................................... 18 

Figura 29. Datos LIDAR de la hoja 732-4396............................................................................... 18 

Figura 30. Datos LIDAR de la hoja 732-4398............................................................................... 19 

Figura 31. Datos LIDAR de la hoja 734-4396............................................................................... 19 

Figura 32. Datos LIDAR de la hoja 734-4398............................................................................... 19 

Figura 33. Datos LIDAR unidos ................................................................................................... 20 

Figura 34. Datos LIDAR zona de estudio ..................................................................................... 21 

Figura 35. Zona estudio filtrada dos veces ................................................................................. 22 

Figura 36. Zona estudio filtrada una vez .................................................................................... 22 

Figura 37. Zona estudio filtrada tres veces ................................................................................. 23 

Figura 38. Zona de estudio filtrada final ..................................................................................... 23 

Figura 39. Modelo digital del terreno (MDT) .............................................................................. 24 

Figura 40. Modelo digital terreno en formato ASCII................................................................... 25 

Figura 41. Modelo digital del terreno en QGIS ........................................................................... 26 

Figura 42. Parámetros de la herramienta pendiente ................................................................. 26 

Figura 43. Mapa de pendiente en QGIS...................................................................................... 26 

Figura 44. Parámetros de la herramienta Least Cost Path ......................................................... 27 

file:///C:/Users/toshiba/Desktop/ESTUDIO%20DE%20ACCESO%20AL%20FORO%20ROMANO%20DE%20SAGUNTO%20EN%20LA%20EDAD%20ANTIGUA%20A%20PARTIR%20DE%20MODELIZACIÓN%203D.docx%23_Toc50285873
file:///C:/Users/toshiba/Desktop/ESTUDIO%20DE%20ACCESO%20AL%20FORO%20ROMANO%20DE%20SAGUNTO%20EN%20LA%20EDAD%20ANTIGUA%20A%20PARTIR%20DE%20MODELIZACIÓN%203D.docx%23_Toc50285874
file:///C:/Users/toshiba/Desktop/ESTUDIO%20DE%20ACCESO%20AL%20FORO%20ROMANO%20DE%20SAGUNTO%20EN%20LA%20EDAD%20ANTIGUA%20A%20PARTIR%20DE%20MODELIZACIÓN%203D.docx%23_Toc50285876
file:///C:/Users/toshiba/Desktop/ESTUDIO%20DE%20ACCESO%20AL%20FORO%20ROMANO%20DE%20SAGUNTO%20EN%20LA%20EDAD%20ANTIGUA%20A%20PARTIR%20DE%20MODELIZACIÓN%203D.docx%23_Toc50285877
file:///C:/Users/toshiba/Desktop/ESTUDIO%20DE%20ACCESO%20AL%20FORO%20ROMANO%20DE%20SAGUNTO%20EN%20LA%20EDAD%20ANTIGUA%20A%20PARTIR%20DE%20MODELIZACIÓN%203D.docx%23_Toc50285878
file:///C:/Users/toshiba/Desktop/ESTUDIO%20DE%20ACCESO%20AL%20FORO%20ROMANO%20DE%20SAGUNTO%20EN%20LA%20EDAD%20ANTIGUA%20A%20PARTIR%20DE%20MODELIZACIÓN%203D.docx%23_Toc50285879
file:///C:/Users/toshiba/Desktop/ESTUDIO%20DE%20ACCESO%20AL%20FORO%20ROMANO%20DE%20SAGUNTO%20EN%20LA%20EDAD%20ANTIGUA%20A%20PARTIR%20DE%20MODELIZACIÓN%203D.docx%23_Toc50285880
file:///C:/Users/toshiba/Desktop/ESTUDIO%20DE%20ACCESO%20AL%20FORO%20ROMANO%20DE%20SAGUNTO%20EN%20LA%20EDAD%20ANTIGUA%20A%20PARTIR%20DE%20MODELIZACIÓN%203D.docx%23_Toc50285881
file:///C:/Users/toshiba/Desktop/ESTUDIO%20DE%20ACCESO%20AL%20FORO%20ROMANO%20DE%20SAGUNTO%20EN%20LA%20EDAD%20ANTIGUA%20A%20PARTIR%20DE%20MODELIZACIÓN%203D.docx%23_Toc50285882
file:///C:/Users/toshiba/Desktop/ESTUDIO%20DE%20ACCESO%20AL%20FORO%20ROMANO%20DE%20SAGUNTO%20EN%20LA%20EDAD%20ANTIGUA%20A%20PARTIR%20DE%20MODELIZACIÓN%203D.docx%23_Toc50285883
file:///C:/Users/toshiba/Desktop/ESTUDIO%20DE%20ACCESO%20AL%20FORO%20ROMANO%20DE%20SAGUNTO%20EN%20LA%20EDAD%20ANTIGUA%20A%20PARTIR%20DE%20MODELIZACIÓN%203D.docx%23_Toc50285884
file:///C:/Users/toshiba/Desktop/ESTUDIO%20DE%20ACCESO%20AL%20FORO%20ROMANO%20DE%20SAGUNTO%20EN%20LA%20EDAD%20ANTIGUA%20A%20PARTIR%20DE%20MODELIZACIÓN%203D.docx%23_Toc50285886
file:///C:/Users/toshiba/Desktop/ESTUDIO%20DE%20ACCESO%20AL%20FORO%20ROMANO%20DE%20SAGUNTO%20EN%20LA%20EDAD%20ANTIGUA%20A%20PARTIR%20DE%20MODELIZACIÓN%203D.docx%23_Toc50285887
file:///C:/Users/toshiba/Desktop/ESTUDIO%20DE%20ACCESO%20AL%20FORO%20ROMANO%20DE%20SAGUNTO%20EN%20LA%20EDAD%20ANTIGUA%20A%20PARTIR%20DE%20MODELIZACIÓN%203D.docx%23_Toc50285888
file:///C:/Users/toshiba/Desktop/ESTUDIO%20DE%20ACCESO%20AL%20FORO%20ROMANO%20DE%20SAGUNTO%20EN%20LA%20EDAD%20ANTIGUA%20A%20PARTIR%20DE%20MODELIZACIÓN%203D.docx%23_Toc50285889
file:///C:/Users/toshiba/Desktop/ESTUDIO%20DE%20ACCESO%20AL%20FORO%20ROMANO%20DE%20SAGUNTO%20EN%20LA%20EDAD%20ANTIGUA%20A%20PARTIR%20DE%20MODELIZACIÓN%203D.docx%23_Toc50285890
file:///C:/Users/toshiba/Desktop/ESTUDIO%20DE%20ACCESO%20AL%20FORO%20ROMANO%20DE%20SAGUNTO%20EN%20LA%20EDAD%20ANTIGUA%20A%20PARTIR%20DE%20MODELIZACIÓN%203D.docx%23_Toc50285891
file:///C:/Users/toshiba/Desktop/ESTUDIO%20DE%20ACCESO%20AL%20FORO%20ROMANO%20DE%20SAGUNTO%20EN%20LA%20EDAD%20ANTIGUA%20A%20PARTIR%20DE%20MODELIZACIÓN%203D.docx%23_Toc50285892
file:///C:/Users/toshiba/Desktop/ESTUDIO%20DE%20ACCESO%20AL%20FORO%20ROMANO%20DE%20SAGUNTO%20EN%20LA%20EDAD%20ANTIGUA%20A%20PARTIR%20DE%20MODELIZACIÓN%203D.docx%23_Toc50285893
file:///C:/Users/toshiba/Desktop/ESTUDIO%20DE%20ACCESO%20AL%20FORO%20ROMANO%20DE%20SAGUNTO%20EN%20LA%20EDAD%20ANTIGUA%20A%20PARTIR%20DE%20MODELIZACIÓN%203D.docx%23_Toc50285894
file:///C:/Users/toshiba/Desktop/ESTUDIO%20DE%20ACCESO%20AL%20FORO%20ROMANO%20DE%20SAGUNTO%20EN%20LA%20EDAD%20ANTIGUA%20A%20PARTIR%20DE%20MODELIZACIÓN%203D.docx%23_Toc50285896
file:///C:/Users/toshiba/Desktop/ESTUDIO%20DE%20ACCESO%20AL%20FORO%20ROMANO%20DE%20SAGUNTO%20EN%20LA%20EDAD%20ANTIGUA%20A%20PARTIR%20DE%20MODELIZACIÓN%203D.docx%23_Toc50285907
file:///C:/Users/toshiba/Desktop/ESTUDIO%20DE%20ACCESO%20AL%20FORO%20ROMANO%20DE%20SAGUNTO%20EN%20LA%20EDAD%20ANTIGUA%20A%20PARTIR%20DE%20MODELIZACIÓN%203D.docx%23_Toc50285908
file:///C:/Users/toshiba/Desktop/ESTUDIO%20DE%20ACCESO%20AL%20FORO%20ROMANO%20DE%20SAGUNTO%20EN%20LA%20EDAD%20ANTIGUA%20A%20PARTIR%20DE%20MODELIZACIÓN%203D.docx%23_Toc50285909
file:///C:/Users/toshiba/Desktop/ESTUDIO%20DE%20ACCESO%20AL%20FORO%20ROMANO%20DE%20SAGUNTO%20EN%20LA%20EDAD%20ANTIGUA%20A%20PARTIR%20DE%20MODELIZACIÓN%203D.docx%23_Toc50285910
file:///C:/Users/toshiba/Desktop/ESTUDIO%20DE%20ACCESO%20AL%20FORO%20ROMANO%20DE%20SAGUNTO%20EN%20LA%20EDAD%20ANTIGUA%20A%20PARTIR%20DE%20MODELIZACIÓN%203D.docx%23_Toc50285914
file:///C:/Users/toshiba/Desktop/ESTUDIO%20DE%20ACCESO%20AL%20FORO%20ROMANO%20DE%20SAGUNTO%20EN%20LA%20EDAD%20ANTIGUA%20A%20PARTIR%20DE%20MODELIZACIÓN%203D.docx%23_Toc50285915


Página | 6  
 

Figura 45. Ruta de menor coste ................................................................................................. 28 

Figura 46. Cómo instalar un complemento en QGIS .................................................................. 28 

Figura 47. Administrador de complementos de QGIS ................................................................ 28 

Figura 48. Modelo digital del terreno en SAGA .......................................................................... 29 

Figura 49. Parámetros de la herramienta Slope, Aspect, Curvature........................................... 29 

Figura 50. Mapa de pendientes en SAGA ................................................................................... 30 

Figura 51. Parámetros de la herramienta Acccumulated Cost ................................................... 31 

Figura 52. Mapa de coste acumulado en SAGA .......................................................................... 31 

Figura 53. Parámetros de la herramienta Least Cost Paths ........................................................ 32 

Figura 54. Ruta de menor coste en SAGA ................................................................................... 32 

Figura 55. Parámetros de la herramienta pendiente de SAGA en QGIS ..................................... 33 

Figura 56. Mapa de pendientes de SAGA en QGIS ..................................................................... 34 

Figura 57. Parámetros de la herramienta Accumulated Cost de SAGA en QGIS......................... 35 

Figura 58. Coste acumulado de SAGA en QGIS ........................................................................... 35 

Figura 59. Parámetros de la herramienta Least Cost Paths de SAGA en QGIS ........................... 36 

Figura 60. Ruta de menor coste de SAGA en QGIS ..................................................................... 37 

Figura 61. Modelo digital del terreno en ArcMap ...................................................................... 38 

Figura 62. Parámetros de la herramienta Slope en ArcMap....................................................... 38 

Figura 63. Mapa de pendientes en ArcMap ............................................................................... 39 

Figura 64. Parámetros de la herramienta Reclassify en ArcMap ................................................ 40 

Figura 65. Método de reclasificación empleado ........................................................................ 40 

Figura 66. Mapa de pendientes reclasificado ............................................................................. 41 

Figura 67. Parámetros de la herramienta Polygon To Raster en ArcMap ................................... 42 

Figura 68. Capa ráster de la zona de estudio .............................................................................. 42 

Figura 69. Parámetros de la herramienta Weighted Overlay en ArcMap ................................... 43 

Figura 70. Mapa de superposición ponderada ........................................................................... 44 

Figura 71. Parámetros de la herramienta Cost Distance en ArcMap .......................................... 45 

Figura 72. Mapa de distancia de coste ....................................................................................... 45 

Figura 73. Parámetros de la herramienta Cost Back Link en ArcMap ......................................... 46 

Figura 74. Mapa de menor vínculo de coste .............................................................................. 47 

Figura 75. Parámetros de la herramienta Cost Path en ArcMap ................................................ 48 

Figura 76. Ruta de menor coste en ArcMap ............................................................................... 48 

Figura 77. Parámetros de la herramienta Raster to Polyline en ArcMap ................................... 49 

Figura 78. .Ruta de menor coste como polilínea en ArcMap ...................................................... 49 

Figura 79. Logo de MoldeBuilder en ArcMap ............................................................................. 50 

Figura 80. Modelo de trabajo de ModelBuilder en ArcMap ....................................................... 50 

Figura 81. Model Builder ............................................................................................................ 50 

Figura 82. Ruta de menor coste en QGIS sobre una ortofoto .................................................... 51 

Figura 83. Ruta de menor coste de SAGA en QGIS sobre una ortofoto ...................................... 52 

Figura 84. Ruta de menor coste en SAGA ................................................................................... 52 

Figura 85. Rutas de menor coste en SAGA y de SAGA en QGIS sobre ortofoto .......................... 53 

Figura 86. Ruta de menor coste en ArcMap sobre ortofoto ....................................................... 53 

Figura 87. Rutas de menor coste sobre ortofoto ........................................................................ 54 

Figura 88. Coste licencias ArcGIS Desktop en EEUU ................................................................... 57 

Figura 89. Rutas de menor coste sobre ortofoto ........................................................................ 59 

file:///C:/Users/toshiba/Desktop/ESTUDIO%20DE%20ACCESO%20AL%20FORO%20ROMANO%20DE%20SAGUNTO%20EN%20LA%20EDAD%20ANTIGUA%20A%20PARTIR%20DE%20MODELIZACIÓN%203D.docx%23_Toc50285918
file:///C:/Users/toshiba/Desktop/ESTUDIO%20DE%20ACCESO%20AL%20FORO%20ROMANO%20DE%20SAGUNTO%20EN%20LA%20EDAD%20ANTIGUA%20A%20PARTIR%20DE%20MODELIZACIÓN%203D.docx%23_Toc50285919
file:///C:/Users/toshiba/Desktop/ESTUDIO%20DE%20ACCESO%20AL%20FORO%20ROMANO%20DE%20SAGUNTO%20EN%20LA%20EDAD%20ANTIGUA%20A%20PARTIR%20DE%20MODELIZACIÓN%203D.docx%23_Toc50285951
file:///C:/Users/toshiba/Desktop/ESTUDIO%20DE%20ACCESO%20AL%20FORO%20ROMANO%20DE%20SAGUNTO%20EN%20LA%20EDAD%20ANTIGUA%20A%20PARTIR%20DE%20MODELIZACIÓN%203D.docx%23_Toc50285952
file:///C:/Users/toshiba/Desktop/ESTUDIO%20DE%20ACCESO%20AL%20FORO%20ROMANO%20DE%20SAGUNTO%20EN%20LA%20EDAD%20ANTIGUA%20A%20PARTIR%20DE%20MODELIZACIÓN%203D.docx%23_Toc50285961


ESTUDIO DE ACCESO AL FORO ROMANO DE SAGUNTO EN LA EDAD ANTIGUA A PARTIR DE MODELIZACIÓN 3D 

   

Página | 7 
 

Figura 90. Curvas de nivel de la zona de estudio ........................................................................ 59 

Figura 91. Construcciones romanas ........................................................................................... 64 

Figura 92. Polígono zona de estudio .......................................................................................... 64 

Figura 93. Parámetros de la herramienta "Diferencia" en QGIS ................................................. 65 

Figura 94. Zona estudio sin construcciones ................................................................................ 65 

Figura 95. Parámetros herramienta "Merge" en ArcMap .......................................................... 66 

Figura 96. Tabla de atributos de "capa_vectorial_zona_estudio" .............................................. 66 

Figura 97. “capa_vectorial_zona_estudio” en ArcMap .............................................................. 66 

 

ÍNDICE DE TABLAS 
Tabla 1. Convenio de trabajo del sector de Oficinas y Despachos de Valencia del 2019 ............ 56 

Tabla 2. Coste directo del presupuesto ...................................................................................... 57 

Tabla 3. Coste directo del presupuesto ...................................................................................... 58 

Tabla 4. Presupuesto total del  proyecto.................................................................................... 58 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

file:///C:/Users/toshiba/Desktop/ESTUDIO%20DE%20ACCESO%20AL%20FORO%20ROMANO%20DE%20SAGUNTO%20EN%20LA%20EDAD%20ANTIGUA%20A%20PARTIR%20DE%20MODELIZACIÓN%203D.docx%23_Toc50285962
file:///C:/Users/toshiba/Desktop/ESTUDIO%20DE%20ACCESO%20AL%20FORO%20ROMANO%20DE%20SAGUNTO%20EN%20LA%20EDAD%20ANTIGUA%20A%20PARTIR%20DE%20MODELIZACIÓN%203D.docx%23_Toc50285963
file:///C:/Users/toshiba/Desktop/ESTUDIO%20DE%20ACCESO%20AL%20FORO%20ROMANO%20DE%20SAGUNTO%20EN%20LA%20EDAD%20ANTIGUA%20A%20PARTIR%20DE%20MODELIZACIÓN%203D.docx%23_Toc50285964
file:///C:/Users/toshiba/Desktop/ESTUDIO%20DE%20ACCESO%20AL%20FORO%20ROMANO%20DE%20SAGUNTO%20EN%20LA%20EDAD%20ANTIGUA%20A%20PARTIR%20DE%20MODELIZACIÓN%203D.docx%23_Toc50285968
file:///C:/Users/toshiba/Desktop/ESTUDIO%20DE%20ACCESO%20AL%20FORO%20ROMANO%20DE%20SAGUNTO%20EN%20LA%20EDAD%20ANTIGUA%20A%20PARTIR%20DE%20MODELIZACIÓN%203D.docx%23_Toc50285969


Página | 8  
 

1.- INTRODUCCIÓN Y OBJETIVO DEL PROYECTO 
La ciudad de Sagunto se implanta en la vertiente meridional de la sierra Calderona, siendo esta 

el límite sur de la zona urbana, y extendiéndose hasta el cauce del río Palancia, siendo este el 

límite norte de la población.  

La ciudad se encuentra situada en un lugar estratégico debido a su ubicación topográfica y a su 

localización como nudo de caminos terrestres y marítimos y está protegida por el castillo, que se 

localiza en lo alto de una de las estribaciones de la sierra Calderona, con una longitud cercana a 

un kilómetro. Este castillo se divide en siete plazas distintas: la plaza de Almenara, la más 

oriental; la plaza de Armas o de Santa María Magdalena, donde se pueden ver los restos del foro 

romano y forma el núcleo principal del castillo; la plaza de Conejera, a la que se accede a través 

de la plaza de Armas; la plaza de la Ciudadela, la cual es la más elevada del castillo; la plaza de 

Dos de Mayo, que mira a poniente; y las plazas de San Fernando y de Estudiantes. 

Durante la época romana, la ciudad se organiza hasta incluir el río Palancia, que es atravesado 

por un puente, desde el que comienza el eje norte-sur de la ciudad. La orografía de la ciudad se 

desenvolupa en terrazas, desde el río Palancia hasta la plataforma del teatro, la plaza del fórum 

y la plaza de la Ciudadela, que se encuentra en el área occidental del castillo. 

La construcción del circo romano, a mediados del siglo II, delante del puente del río Palancia, 

supone un obstáculo para el acceso al área del teatro y el fórum y al trazado original de la 

ciudad. Por tanto, el objetivo principal de este proyecto es indicar, de una forma aproximada, el 

camino que podía ser usado en la antigüedad, durante el asentamiento romano, para trasladarse 

desde el puente que atraviesa el río Palancia al acceso este del castillo mediante la modelización 

de nubes de puntos LIDAR. Para ello, se realizarán una serie de pasos y operaciones para el 

tratamiento y estudio de estos datos. 

En primer lugar, se estudiarán 

y analizarán los datos LIDAR 

para obtener un modelo digital 

de terreno (MDT) de la zona 

que abarcan los puntos de 

interés. 

Acto seguido, mediante una 

serie de diversos procesos se 

intentará calcular y obtener la 

mejor ruta que comunica el 

puente con el castillo. 

Y, para finalizar, se realizará 

una composición de mapa 

para representar los resultados obtenidos en el proyecto. 

 

  

Figura 1. Ortofoto del vuelo americano de 1956 de la zona de Sagunto 
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2.- ¿QUÉ ES EL LIDAR? 
El acrónimo LIDAR significa “Light Detection and Ranging” o “Laser Imaging Detection and 

Ranging”, es decir, detección de luz y rango y cuya definición según Tesauro 2013 de la 

Biblioteca Agrícola Nacional de los Estado Unidos es: 

“Utilización de rayos láser pulsados y reflejados 

sobre un objeto para medir distancia, posición o velocidad.” 

El sistema de escaneo mediante LIDAR funciona de forma aerotransportada (ALS), esto significa 

que el láser utilizado para la medición de los objetos se encuentra en una aeronave, sea una 

avioneta (pilotada por un piloto) o un dron (pilotada de forma remota), y trabaja con dos 

movimientos diferentes: la trayectoria del avión, que es el desplazamiento longitudinal y el espejo 

que recibe la luz que llega desde el láser, que es movimiento transversal. 

A la hora de realizar mediciones, el sistema LIDAR utiliza un conjunto de elementos básicos que 

permiten obtener buenos resultados, estos instrumentos son:  

 Un sistema GNSS, que consta de dos 

o más GPS, uno que se encuentra en 

la superficie, el cual actúa como 

estación de referencia, y otro situado 

en la aeronave, que hace la función de 

receptor GPS, para obtener la posición 

y altura de la aeronave. 

 Una unidad de medición inercial, que 

indica la trayectoria y los giros 

realizados por la avioneta.  

 El sensor láser, que emite pulsos de 

luz para determinar la distancia desde el sensor al terreno medido. 

Con todo esto, este sistema tiene la capacidad de obtener un mapa de puntos del terreno que 

permite conocer su geografía de una forma detallada. 

Los sistemas LIDAR pueden ser clasificados de dos maneras diferentes: por un lado, según el 

tipo de láser utilizado y, por otro, según el escaneo del terreno. 

 Tipo de láser: puede ser lidar a pulsos o de medición de fase. 

o Lidar a pulsos: el emisor emite pulsos de luz y la distancia entre el sensor y el 

terreno se mide calculando el tiempo que tarda el pulso desde el momento que 

se emite hasta que es recibido. 

o Lidar de medición de fase: aquí, el emisor emite un haz láser continuo y mide la 

diferencia de fase entre la señal emitida y la señal reflejada. 

 

Figura 2. Componentes básicos de un sistema LIDAR 
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 Tipo de escaneo del terreno: puede ser lineal, en zigzag, elíptico o de fibra óptica. 

o Lineal: el sistema dispone de un espejo rotatorio que va desviando el haz láser y 

produce un patrón de escaneado de líneas paralelas en el terreno.   

o Zigzag: en este sistema el espejo incorporado es rotatorio en dos sentidos y, 

como resultado, produce líneas en zigzag como patrón de escaneado. 

o Elíptico: aquí, hay dos espejos que desvían el haz láser y producen, como 

patrón de escaneado, un escaneado elíptico. 

o De fibra óptica: mediante unos pequeños espejos, el haz láser es desviado 

desde la fibra central del sistema a las fibras laterales, que están montadas 

alrededor del eje del sistema, y producen un escaneado en forma de 

circunferencias solapadas.  

 

 

Figura 3. Tipo de escaneo del terreno 
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3.- SOFWARE UTILIZADO 
Para la realización de este trabajo se han utilizado cinco softwares diferentes: LASTOOLS, 

FUSION, QGIS, SAGA y ARCGIS. A continuación, se va a explicar de una forma rápida y 

concisa las características principales de cada uno de ellos. 

3.1.- LASTOOLS 

LAStools es un conjunto de herramientas que permiten un manejo y procesamiento eficiente de 

datos LIDAR aerotransportado y han sido creadas por Martin Isenburg de la Universidad de 

Carolina del Norte. 

Estas herramientas pueden convertir millones de puntos 

LIDAR en productos de fácil uso a grandes velocidades y 

con bajos requisitos de memoria y, por tanto, son muy útiles 

para el procesamiento LIDAR multinúcleo por lotes. 

Dentro de todas las herramientas que contiene LAStools, en 

este proyecto, solo se va a utilizar la herramienta LASzip. 

LASzip es un software de código abierto que permite 

comprimir archivos LAS en archivos LAZ. Estas 

compresiones representan entre un 7 y un 20 por ciento 

del tamaño original de los datos y conservan con gran 

precisión cada bit de información. 

Además, LASzip también permite descomprimir archivos 

LAZ a archivos LAS. 

 

3.2.- FUSION 

Fusion es un software que permite el análisis y visualización 

de datos LIDAR en un entorno 3D. Puede combinar datos 

LIDAR, datos de campo, capas SIG y modelos de superficie 

para poder hacer una buena valoración de los datos 

geoespaciales.  

Este ha sido creado y desarrollado por el “Servicio Forestal del 

Departamento de Agricultura de Estados Unidos (USDA)” para 

ayudar a entender, analizar e investigar datos LIDAR. 

Su sistema de análisis y visualización está formado por dos programas principales: FUSION y el 

visor de datos LIDAR (LDV). 

 FUSION: es la interfaz principal y consiste en una ventana de control y otra de 

visualización gráfica que presentan los datos en 2D. 

Figura 4. Logotipo de LAStools 

Figura 5. Espacio de trabajo de LASzip 

Figura 6. Logo de FUSION 
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 LDV: es el visualizador 3D de los datos LIDAR que permite realizar una valoración de los 

subconjuntos de datos espaciales. 

Por otro lado, está la ventana PDQ, que permite tener una visualización 3D de los datos y los 

resultados obtenidos de una forma rápida y sencilla, basta con arrastrar el archivo sobre él y se 

abrirá sin ningún problema. 

 

3.3.- QGIS 
QGIS es una aplicación profesional de Sistemas de Información Geográfica de código abierto y, 

por tanto, es un software libre. 

Este programa permite trabajar con una alta variedad de datos (vectoriales, ráster, etc.) y puede 

visualizar, gestionar gran cantidad de datos, editarlos, analizarlos y, además, se pueden diseñar 

mapas o planos para, a la postre, poder imprimirlos o guardarlos en formato PDF. 

En este proyecto se ha utilizado la versión 3.2.0 de QGIS. 

 

                  

 

 

 

 

 

Figura 8. Interfaz principal de FUSION Figura 7. Espacio de trabajo de PDQ 

Figura 9. Espacio de trabajo de QGIS 

Figura 10. Logo de QGIS 
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3.4.- SAGA 

SAGA, cuyo significado es Sistema para Análisis Geocientíficos Automatizados, es un Sistema 

de Información Geográfica (SIG) de software libre y de código abierto utilizado para analizar y 

editar datos espaciales.  

Este software incluye un gran número de módulos que permiten analizar datos vectoriales, 

imágenes, tablas y cuadrículas, así como, operaciones geoestadísticas, clasificación de 

imágenes y análisis del terreno, entre otros. Además, para favorecer la aplicación de métodos 

científicos y facilitar el acceso a ellos se ha utilizado una interfaz de programación API y una 

interfaz gráfica de usuario GUI. 

En las dos últimas décadas, SAGA ha sido desarrollado y actualizado en el Instituto de geografía 

de la Universidad de Hamburgo. 

En este proyecto se ha utilizado la versión 2.3.2. 

 

 

 

 

 

 

 

 

3.5.- ARCGIS 

ArcGis es un Sistema de Información Geográfica (SIG) que contiene un grupo de aplicaciones 

que permiten recopilar, analizar, administrar, compartir y distribuir información geográfica. Estas 

aplicaciones se agrupan en diferentes familias temáticas como ArcGIS Server, ArcGIS Movil y 

ArcGIS Desktop. 

 

Figura 13. Aplicaciones de ArcGIS 

Figura 12. Logo de SAGA 

Figura 11. Espacio de trabajo de SAGA 
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Los softwares de ArcGIS son producidos y comercializados por ESRI y, por tanto, son softwares 

privados, es decir, se necesita una licencia de pago para poder trabajar con ellos.  

En este proyecto, se ha empelado la versión 10.1 de ArcMap, que es una aplicación de escritorio 

y pertenece a la familia ArGIS Desktop. 

ArcMap es la aplicación de escritorio principal de ArcGIS 

utilizada para la realización de las tareas habituales de SIG, 

como la creación, visualización y edición de los datasets y el 

diseño de los mapas para imprimir. Además, representa la 

información geográfica que se está usando como una 

colección de capas y otros elementos de un mapa.  

El espacio de trabajo de ArcMap tiene dos vistas diferentes: la vista de datos y la vista de 

composición de mapa. 

 Vista de datos: donde se pueden visualizar los datos mediante una ventana geográfica y 

se puede mostrar y trabajar con la información geográfica. 

 Vista de composición de mapa: donde los elementos de mapa están estructurados en 

una página para la impresión del mapa. 

 

 

 

 

 

 

Figura 1.  Figura 14. Logo de ArcMAP 

Figura 15. Vista de datos de ArcMAP 
Figura 16. Vista de composición de mapa de ArcMAP 
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4.- DATOS DE PARTIDA 
En este proyecto, los datos a utilizar se han descargado del Centro de Descargas del Centro 

Nacional de Información Geográfica (CNIG). Estos datos han sido cuatro archivos de datos 

LIDAR y una ortofoto de máxima calidad.  

4.1.- Datos LIDAR 

 

 

 

 

 

 

 

Para obtener los datos LIDAR se ha entrado en la 

opción “Modelos Digitales de Elevaciones. Una vez 

dentro, se ha  elegido la opción “LIDAR 2ª 

Cobertura” y se han seleccionado y descargado los 

archivos PNOA_2015_VAL_732_4396_ORT_CLA_RGB, 

PNOA_2015_VAL_732_4396_ORT_CLA_RGB, 

PNOA_2015_VAL_732_4396_ORT_CLA_RGB y 

PNOA_2015_VAL_732_4396_ORT_CLA_RGB   en 

formato LAZ, los cuales corresponden a la zona 

de estudio. 

 

 

 

 

 

 

 

 

 

 

Figura 18. Tipos de modelos digitales de elevaciones 

Figura 17. Página principal del CNIG 

Figura 19. Archivos LIDAR de la zona de Sagunto 
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4.2.- Ortofoto de máxima calidad 

 

 

 

 

 

 

 

Para obtener la ortofoto del PNOA, se ha entrado 

en la opción “Fotos e imágenes aéreas”. Una vez 

dentro, se ha elegido en “Ortofoto PNOA Máxima 

Calidad” y se ha seleccionado y descargado el 

archivo “PNOA_MA_OF_ETRS89_HU30_h50_0668” 

en formato ecw, que corresponde a la zona de 

estudio de Sagunto.  

 

 

 

 

 

 

 

 

 

 

 

 

 

Figura 20. Página principal del CNIG 

Figura 21. Tipos de ortofotos e imágenes de satélite 

Figura 22. Ortofotos de la zona de Sagunto 
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5.- METODOLOGÍA 
Para el tratamiento y el análisis de los datos se van a utilizar los cinco softwares que se han 

expuesto en el apartado 3 y se explicará, de una forma clara, el proceso llevado a cabo para 

obtener el resultado final, así como, imágenes que ilustren los resultados intermedios que se van 

obteniendo. 

 

Figura 23. Diagrama de flujo 

5.1.- LASZIP 

Con este programa, se pretende descomprimir los datos LIDAR en formato LAZ descargados del 

CNIG al formato LAS, para que sea más fácil el uso de la nube de puntos en el programa 

FUSION. 

  

La imagen de la izquierda, 

muestra el espacio de trabajo 

de LASzip, donde se han 

cargado los datos. 

El recuadro rojo indica de 

donde se han cogido y 

cargado los datos. 

El recuadro naranja indica el 

lugar donde se va a dejar el 

archivo descomprimido. 

 

 

Figura 25.  Algoritmo de trabajo de LASZIP para la hoja 732-4396 LIDAR  

Figura 24. Espacio de trabajo de LASZIP 
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Figura 26. Algoritmo de trabajo de LASZIP para la hoja 732-4398 LIDAR 

 

Figura 27. Algoritmo de trabajo de LASZIP para la hoja 734-4396 LIDAR 

 

Figura 28. Algoritmo de trabajo de LASZIP para la hoja 734-4398 LIDAR 

Las figuras 25, 26, 27 y 28 muestran el algoritmo que se ha ejecutado, en este caso laszip, el 

directorio de los datos de entrada y el directorio donde se ha guardado el archivo de salida. 

 

5.2.- FUSION 

En FUSION, se va a realizar el procesamiento y el análisis de los datos LIDAR para obtener, a 

partir de la nube de puntos 3D, un modelo digital de elevaciones (MDE) para poder trabajar con 

él con el programa QGIS. Para ello, se van a utilizar varias de las herramientas de este software, 

las cuales son: mergedata, clipdata, groundfilter, GridSurfaceCreate y DTM2ASCII que serán 

explicadas y descritas a continuación. 

 

Figura 29. Datos LIDAR de la hoja 732-4396 
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Figura 30. Datos LIDAR de la hoja 732-4398 

 

Figura 31. Datos LIDAR de la hoja 734-4396 

 

Figura 32. Datos LIDAR de la hoja 734-4398 
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5.3.1.- Mergedata 

Mergedata combina varios archivos de nubes de puntos LIDAR en un solo archivo. La unión de 

los archivos se realiza por la lectura secuencial de cada archivo de entrada y escribiendo los 

datos de puntos en el archivo de salida. 

La sintaxis de este comando es el siguiente: 

MergeData [switches] DataFile OutputFile  

donde: 

 DataFile: nombre de un archivo de texto que contiene una lista de los nombres de los 

archivos LIDAR (con extensión .txt) o plantilla de archivo de datos LIDAR. 

 OutputFile: nombre del archivo para los datos de salida. Es necesario indicar la 

extensión que tiene el archivo. 

Descritas todas las partes de este comando, se muestra la sintaxis que se ha utilizado para 

obtener la unión de los cuatro archivos LIDAR de la zona de estudio, así como una imagen del 

resultado. 

C:\FUSION\mergedata C:\FUSION\TFG_actual\fusion\datos_lidar.txt 

C:\FUSION\TFG_actual\fusion\datos_lidar_juntos.las 

Donde el archivo datos.txt contiene el directorio de los archivos LIDAR. 

C:\FUSION\TFG_actual\fusion\PNOA_2015_VAL_732-4396_ORT-CLA-RGB.las 

C:\FUSION\TFG_actual\fusion\PNOA_2015_VAL_732-4398_ORT-CLA-RGB.las 

C:\FUSION\TFG_actual\fusion\PNOA_2015_VAL_734-4396_ORT-CLA-RGB.las 

C:\FUSION\TFG_actual\fusion\PNOA_2015_VAL_734-4398_ORT-CLA-RGB.las 

 

Figura 33. Datos LIDAR unidos 
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5.3.2.- Clipdata 

Clipdata hace un recorte de los datos utilizando la parte inferior izquierda y la esquina superior 

derecha de la zona que se quiere recortar.  

La sintaxis de este comando es la siguiente: 

ClipData [switches] InputSpecifier SampleFile [MinX MinY MaxX MaxY]  

donde: 

 Input Specifier: indica el archivo de los datos de entrada, que puede tener  extensión .las 

(si contiene datos LIDAR), .txt o un archivo CSV de FUSION. 

 SampleFile: indica el nombre del archivo de salida que se va a obtener y es necesario 

indicar la extensión del archivo. 

 [MinX MinY]: indican la esquina inferior izquierda de la zona que se va a recortar. 

 [MaxX MaxY]: indican la esquina superior derecha de la zona que se va a recortar 

Descritas todas las partes de este comando, se muestra la sintaxis que se ha utilizado para 

obtener la nube de puntos de la zona de estudio, así como una imagen del resultado.  

C:\FUSION\clipdata C:\FUSION\TFG_actual\fusion\datos_lidar_juntos.las 

C:\FUSION\TFG_actual\fusion\zona_estudio.las 732232 4394861 734483 4396320 

 

Figura 34. Datos LIDAR zona de estudio 

5.3.3.- GroundFilter 

GroundFilter filtra una nube de puntos LIDAR para identificar los puntos del terreno, es decir, 

reconocer aquellos puntos que se encuentran en la superficie del terreno probable. Estos puntos 

son conocidos como puntos bare-earth. 

La sintaxis de este comando es la siguiente:  

GroundFilter [switches] outputfile cellsize datafile1 datafile2 ….  

donde: 
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 Outputfile: nombre del archivo de salida de datos LIDAR que contiene puntos 

clasificados como resultados bare-earth. 

 Cellsize: tamaño de celda usado para modelo de superficies intermedios. 

 datafile1: primer archivo de datos LIDAR de entrada, puede tener formato LDA, LAS, 

ASCII LIDARDAT. 

 datafile2: segundo archivo de datos LIDAR de entrada, puede tener formato LDA, LAS, 

ASCII LIDARDAT. 

Descritas todas las partes de este comando, se muestra la sintaxis que se ha utilizado para 

obtener las nubes de puntos filtradas, así como imágenes de los resultados obtenidos. 

C:\FUSION\Groundfilter /gparam:0.0 /wparam:0.5 /iterations:8 

C:\FUSION\TFG_actual\fusion\zona_filtrada.las 5 

C:\FUSION\TFG_actual\fusion\zona_estudio.las 

C:\FUSION\Groundfilter /gparam:0.0 /wparam:0.3 /iterations:8 

C:\FUSION\TFG_actual\fusion\zona_filtrada_2.las 4 

C:\FUSION\TFG_actual\fusion\zona_filtrada.las 

C:\FUSION\Groundfilter /gparam:0.0 /wparam:0.2 /iterations:8 

C:\FUSION\TFG_actual\fusion\zona_filtrada_3.las 3 

C:\FUSION\TFG_actual\fusion\zona_filtrada_2.las 

C:\FUSION\Groundfilter /gparam:0.0 /wparam:0.1 /iterations:8 

C:\FUSION\TFG_actual\fusion\zona_filtrada_final.las 1 

C:\FUSION\TFG_actual\fusion\zona_filtrada_3.las 

 

 

 

 

Figura 36. Zona estudio filtrada una vez Figura 35. Zona estudio filtrada dos veces 
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5.3.4.- GridSurfaceCreate  

GridSurfaceCreate crea una cuadrícula del modelo de superficie a partir de datos de puntos y 

representa la elevación media de todos los puntos dentro de una celda, por lo que la superficie 

final que produce se extiende dentro del conjunto de puntos bare-earth. 

La sintaxis de este comando es la siguiente: 

GriSurfaceCreate [switches] surfacefille cellsize xyunits zunits coordsys zone horizdatum 

vertdatum datafile1 datafile 2…  

donde: 

 surfacefile: nombre para el fichero de superficie de salida guardado en formato PLANS 

DTM con extensión .dtm. 

 cellsize: tamaño de celda de la cuadrícula para la superficie. 

 xyunits: unidades para los datos X e Y LIDAR, que pueden ser: 

o m: para metros. 

o f: para pies. 

 zunits: unidades para datos de elevación LIDAR, que pueden ser: 

o m: para metros. 

o f: para pies. 

 coordsys: sistema de coordenadas utilizado para la superficie. 

o 0: para desconocido. 

o 1: para coordenadas UTM. 

o 2: para plano de estado.  

 zone: huso de la zona del sistema coordenado utilizado, cuyo valor es 0 si es 

desconocido.   

 horizdatum: dato horizontal para la superficie, que puede tener valor 0, 1 o 2. 

o 0: para desconocido. 

o 1: para NAD27. 

Figura 37. Zona estudio filtrada tres veces Figura 38. Zona de estudio filtrada final 
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o 2: para NAD83. 

 vertdatum: dato vertical para la superficie, que puede tener valor de 0, 1, 2 o 3. 

o 0: para desconocido. 

o 1: para NGVD29. 

o 2: para NADV88. 

o 3: para GRS80. 

 datafile1: primer archivo de datos LIDAR de entrada, puede tener formato LDA, LAS, 

ASCII LIDARDAT. 

 datafile2: segundo archivo de datos LIDAR de entrada, puede tener formato LDA, LAS, 

ASCII LIDARDAT. 

Descritas todas las partes de este comando, se muestra la sintaxis que se ha utilizado para 

obtener el modelo digital del terreno (MDT) de la zona de estudio, así como una imagen del 

resultado. 

C:\FUSION\GridSurfaceCreate C:\FUSION\TFG_actual\fusion\modelo_terreno.dtm 2 m m 1 30 0 

0 C:\FUSION\TFG_actual\fusion\zona_filtrada_final.las 

 

 

Figura 39. Modelo digital del terreno (MDT) 

 

5.3.5.- DTM2ASCII 

DTM2ASCII convierte los datos almacenados en el formato PLANS DTM a archivos ráster ASCII. 

La sintaxis de este comando es la siguiente: 

DTM2ASCII [switches] inputfile [outputfile]  

donde: 

 Inputfile: nombre del archivo con formato PLANS DTM para convertir a formato ráster 

ASCII. 
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 Outputfile: nombre del archivo de salida convertido. 

 Switches: es un conjunto de comandos que tiene esta herramienta para ayudar en la 

conversión de los datos. Para este caso se ha utilizado el switch Raster. 

o Raster: interpreta los puntos DTM como el atributo para una celda y ajusta el 

origen del archivo de cuadrícula ASCII de modo que el punto inferior izquierdo 

es el centro de la celda inferior izquierda de la cuadrícula.  

Descritas todas las partes de este comando, se muestra la sintaxis que se ha utilizado para 

obtener el modelo digital del terreno (MDT) en formato ascii de la zona de estudio, así como una 

imagen del resultado. 

C:\FUSION\DTM2ASCII /raster C:\FUSION\TFG_actual\fusion\modelo_terreno.dtm 

C:\FUSION\TFG_actual\fusion\modelo_terreno_ascii.asc 

 

Figura 40. Modelo digital terreno en formato ASCII 

 

5.4.- QGIS 

El objetivo al que se quiere llegar en QGIS es obtener, de una forma aproximada, el camino que 

se empleaba en la antigüedad para desplazarse desde el puente que cruza el río Palancia al foro 

del castillo. Para ello, se van a realizar un conjunto de operaciones, como el cálculo de un mapa 

de pendientes y máscaras ráster a partir de dichas pendientes. 

La información de partida que se va a utilizar es la capa en formato ascii del modelo digital del 

terreno (MDT) obtenida en FUSION.  
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Figura 41. Modelo digital del terreno en QGIS 

A la hora de cargar la capa, es necesario indicar que el sistema de referencia de las 

coordenadas (SRC) es el ETRS89/UTM Zone 30N cuyo EPSG es 25830. 

5.4.1.- Mapa de pendientes 

El mapa de pendientes se obtiene utilizando la 

herramienta pendiente (slope), que se encuentra 

en la caja de herramientas de QGIS. 

Para un buen funcionamiento de esta 

herramienta  es necesario indicar la capa de 

entrada, en este caso, el modelo digital del 

terreno obtenido en FUSION, el factor Z, que por 

defecto es 1, y se deja así, y el directorio donde 

se quiere guardar la capa de salida con las 

pendientes calculadas. 

Las pendientes resultantes de esta operación 

están en grados (degrees). 

Figura 42. Parámetros de la herramienta pendiente 

Figura 43. Mapa de pendiente en QGIS 
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Otra forma de poder calcular el mapa de pendientes a partir del modelo digital del terreno es 

empleando la herramienta pendiente de la librería GDAL. En este comando, se puede elegir las 

unidades en la que se obtendrán las pendientes (grados o porcentaje) y se puede encontrar 

dentro del menú Raster de QGIS. 

 Raster → Analisis → Pendiente 

5.4.2.- Ruta de menor coste 

Para obtener la ruta de menor coste entre dos puntos se debe utilizar la herramienta “Least Cost 

Path”, que se encuentra en la caja de herramientas de QGIS. A continuación, se indica como 

encontrar dicha herramienta. 

 Cost distance analysis → Least Cost Path 

El comando “Least Cost Path” necesita una serie de datos de entrada para calcular la ruta de 

menor coste, estos datos son: 

 Capa ráster de costo: es una capa numérica que indica el coste necesario de cada 

unidad (píxel) espacial. En este caso, se utiliza el mapa de pendientes que se ha 

obtenido en el apartado anterior. 

 Capa de punto de inicio: es una capa vectorial que contiene el punto de partida de la ruta 

a calcular. 

 Capa de punto final: es una capa vectorial que contiene el punto o puntos de destino de 

la ruta. 

 

Figura 44. Parámetros de la herramienta Least Cost Path 

 El resultado de esta operación va a ser mostrado sobre el mapa de pendientes. 
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Figura 45. Ruta de menor coste 

Si no estuviera cargada la herramienta, se puede instalar el complemento desde el administrador 

de complementos de QGIS, que se encuentra dentro del menú complementos. 

 Complementos → Administrar e instalar complementos 

Una vez en el administrador, en la barra de búsqueda se puede escribir el complemento que se 

busca y, cuando ya se ha encontrado, darle a la opción instalar complemento y la herramienta ya 

estará disponible para ser usada en QGIS. 

 

5.5.- SAGA 
El objetivo al que se quiere llegar en SAGA es el mismo que se tenía con QGIS, es decir, 

obtener, de una forma aproximada, el camino que se empleaba en la antigüedad para 

desplazarse desde el puente que cruza el río Palancia y el castillo. Para ello, se van a realizar un 

conjunto de operaciones, como el cálculo de un mapa de pendientes, la obtención de un mapa 

de costes acumulados y la ruta de menor coste entre los puntos ya indicados.  

La información de partida que se va a utilizar es la capa en formato ascii del modelo digital del 

terreno (MDT) obtenida en FUSION.  

Figura 47. Administrador de complementos de QGIS Figura 46. Cómo instalar un complemento en QGIS 
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Figura 48. Modelo digital del terreno en SAGA 

5.5.1.- Mapa de pendientes 

El mapa de pendientes se obtiene empleando la herramienta “Slope ,Aspect, Curvature” que se 

encuentra en la caja de herramientas de Saga, concretamente, en el grupo de comandos para el 

análisis del terreno. 

 Terrain Analysis → Morphometry → Slope, Aspect, Curvature 

En esta herramienta, solo es necesario indicar una capa de entrada que, en este caso, es el 

modelo digital del terreno obtenido en FUSION. 

 

Figura 49. Parámetros de la herramienta Slope, Aspect, Curvature 

A continuación, se muestra el resultado de esta operación. 
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Figura 50. Mapa de pendientes en SAGA 

5.5.2.- Mapa de costes acumulados 

El mapa de costes acumulados se puede obtener con la herramienta “Accumulated Cost”, que se 

encuentra en la caja de herramientas de SAGA, en concreto, en el grupo de comandos 

correspondientes al análisis de cuadrículas (grid). 

 Grid → Analysis → Accumulated Cost 

El módulo “Accumulated Cost” necesita una serie de datos de entrada para calcular, de forma 

correcta, los costes acumulados de la zona de estudio, estos datos son: 

 Local Cost: es una capa numérica que indica el coste necesario de cada unidad (píxel) 

espacial. En este caso, se utiliza el mapa de pendientes que se ha obtenido en el 

apartado anterior. 

 Direction of Maximum Cost: es una capa que indica la dirección del coste acumulado. En 

este caso, se utiliza también el mapa de pendientes obtenido en el apartado anterior. 

 Destinations: es una capa vectorial que contiene el punto de partida de la ruta de mínimo 

coste que será calculada posteriormente. 
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Figura 51. Parámetros de la herramienta Acccumulated Cost 

A continuación, se muestra una imagen con el mapa de costes acumulados obtenido tras la 

operación realizada. 

 

Figura 52. Mapa de coste acumulado en SAGA 

5.5.3.- Ruta de menor coste 

La ruta de menor coste se puede obtener con la herramienta “Least Cost Paths”, que se 

encuentra en la caja de herramientas de SAGA, concretamente, en el grupo de comandos 

correspondientes al análisis de cuadrículas (grid). 

 Grid → Analysis → Least Cost Paths 

El comando “Least Cost Paths” necesita varios datos de entrada para poder calcular la ruta entre 

los dos puntos. Estos datos son: 
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 Accumulated Cost Surface: es una capa ráster que indica el coste acumulado a lo largo 

de la zona de estudio. En este caso, se utiliza el mapa de costes acumulados obtenido 

en el punto anterior. 

 Source Point(s): es una capa vectorial que contiene el punto o puntos de destino de la 

ruta. 

 

Figura 53. Parámetros de la herramienta Least Cost Paths 

Acto seguido, se muestra la ruta de menor coste obtenida sobre el mapa de costes acumulados 

adquirido anteriormente.  

 

Figura 54. Ruta de menor coste en SAGA 

5.6.- SAGA-QGIS 

En este apartado, se pretende volver a calcular la ruta de menor coste con las herramientas de 

SAGA, pero desde el software QGIS, es decir, en QGIS hay implementadas un conjunto de 

herramientas de SAGA, que son las que serán utilizadas para el análisis de los datos. 
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Esto se realiza para comparar los resultados obtenidos desde el software SAGA y el software 

QGIS y poder visualizar si son iguales. 

Como se ha dicho en el apartado 5.5 el objetivo es obtener, de una forma aproximada, el camino 

que se empleaba en la antigüedad para desplazarse desde el puente que cruza el río y el castillo 

y, para ello, se va a obtener un mapa de pendientes, un mapa de costes acumulados y la ruta de 

menor coste entre los puntos ya indicados.  

5.6.1.- Mapa de pendientes 

El mapa de pendientes se obtiene empleando la herramienta “Slope ,Aspect, Curvature” que se 

encuentra en la caja de herramientas de QGIS, concretamente, en el grupo de comandos para el 

análisis del terreno de SAGA. 

 SAGA → Terrain Analysis − Morphometry → Slope, Aspect, Curvature 

En este módulo, solo es necesario indicar una capa de entrada que, en este caso, es el modelo 

digital del terreno obtenido en FUSION 

 

Figura 55. Parámetros de la herramienta pendiente de SAGA en QGIS 

A continuación, se muestra una imagen con el resultado obtenido tras el uso de esta 

herramienta.  
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Figura 56. Mapa de pendientes de SAGA en QGIS 

5.6.2.- Mapa costes acumulados 

El mapa de costes acumulados se puede obtener con la herramienta “Accumulated Cost”, que se 

encuentra en la caja de herramientas de QGIS, en concreto, en el grupo de comandos 

correspondientes al análisis ráster de SAGA. 

 SAGA → Raster Analysis → Accumulated Cost 

El módulo “Accumulated Cost” necesita una serie de datos de entrada para calcular, de forma 

correcta, los costes acumulados de la zona de estudio, estos datos son: 

 Local Cost: es una capa numérica que indica el coste necesario de cada unidad (píxel) 

espacial. En este caso, se utiliza el mapa de pendientes que se ha obtenido en el 

apartado 5.6.1. 

 Direction of Maximum Cost: es una capa que indica la dirección del coste acumulado. En 

este caso, se utiliza también el mapa de pendientes obtenido en el apartado 5.6.1. 

 Destinations: es una capa vectorial que contiene el punto de partida de la ruta de mínimo 

coste que será calculada posteriormente. 
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Figura 57. Parámetros de la herramienta Accumulated Cost de SAGA en QGIS 

A continuación, se muestra una imagen con el mapa de costes acumulados obtenido tras la 

operación realizada. 

 

Figura 58. Coste acumulado de SAGA en QGIS 

5.6.3.- Ruta de menor coste 

La ruta de menor coste se puede obtener con la herramienta “Least Cost Paths”, que se 

encuentra en la caja de herramientas de QGIS, concretamente, en el grupo de comandos 

correspondientes al análisis raster de SAGA. 
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 SAGA → Raster Analysis → Least Cost Paths 

El módulo “Least Cost Paths” necesita varios datos de entrada para poder calcular la ruta entre 

los dos puntos. Estos datos son: 

 Accumulated Cost Surface: es una capa ráster que indica el coste acumulado a lo largo 

de la zona de estudio. En este caso, se utiliza el mapa de costes acumulados obtenido 

en el punto anterior. 

 Source Point(s): es una capa vectorial que contiene el punto o puntos de destino de la 

ruta. 

 

Figura 59. Parámetros de la herramienta Least Cost Paths de SAGA en QGIS 

Ahora, se muestra la ruta de menor coste obtenida sobre el mapa de costes acumulados 

adquirido anteriormente. 



ESTUDIO DE ACCESO AL FORO ROMANO DE SAGUNTO EN LA EDAD ANTIGUA A PARTIR DE MODELIZACIÓN 3D 

   

Página | 37 
 

 

Figura 60. Ruta de menor coste de SAGA en QGIS 

 

5.7.- ARCGIS 
El objetivo al que se quiere llegar en ArcGis, concretamente en ArcMap, es el mismo que se 

tenía con QGIS y SAGA, es decir, obtener, de una forma aproximada, el camino que se 

empleaba en la antigüedad para desplazarse desde el puente que cruza el río Palancia y el 

castillo. Para ello, se van a realizar un conjunto de operaciones, como un mapa de pendientes, la 

reclasificación del mapa de pendientes, un mapa de superposición ponderada, un mapa de 

distancia de coste, un mapa de menor vínculo de coste y la ruta de menor coste entre los puntos 

ya indicados.  

La información de partida que se va a utilizar es la capa en formato ascii del modelo digital del 

terreno (MDT) obtenida en FUSION.  



Página | 38  
 

 

Figura 61. Modelo digital del terreno en ArcMap 

5.7.1.- Mapa de pendientes 

El mapa de pendientes se puede obtener empleando la herramienta “Slope”, que se encuentra 

en la caja de herramientas (ArcToolbox), concretamente, en el grupo de comandos para el 

análisis espacial. 

 Spatial Analyst → Surface → Slope 

Esta herramienta identifica la pendiente de cada una de las celdas de una superficie ráster y 

necesita, como dato de entrada, un modelo digital del terreno. En este caso, la capa de entrada 

que se va a utilizar es el modelo digital del terreno obtenido en FUSION.  

 

Figura 62. Parámetros de la herramienta Slope en ArcMap 

A continuación, se muestra una imagen con el resultado obtenido tras la operación realizada. 
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Figura 63. Mapa de pendientes en ArcMap 

5.7.2.- Reclasificación de mapa de pendientes 

Para poder reclasificar el mapa de pendientes obtenido anteriormente, es necesario utilizar la 

herramienta “Reclassify”, que se encuentra en la caja de herramientas (ArcToolbox), en 

concreto, en el grupo de módulos de herramientas para el análisis espacial.    

 Spatial Analys Tools → Reclass → Reclassify 

En esta herramienta, se utiliza como parámetro de reclasificación los rangos de valores que 

contiene el mapa de pendientes y muestra una tabla que define la forma en la que se 

reclasificarán estos valores. 
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Figura 64. Parámetros de la herramienta Reclassify en ArcMap 

El método de reclasificación empleado ha sido “Natural Breaks”, donde se han creado nueve 

clases teniendo en cuenta los valores que se habían utilizado en el cálculo del mapa de 

pendientes. De esta manera, no se altera la distribución ni la resolución del mapa, si no, que se 

modifica la forma de numerar e indicar los distintos rangos o clases de pendientes existentes. 

 

Figura 65. Método de reclasificación empleado 
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Ahora, se muestra una imagen que permite observar el mapa de pendientes, obtenido en el 

apartado anterior, reclasificado. 

 

Figura 66. Mapa de pendientes reclasificado 

5.7.3.- Rasterizar la capa vectorial de la zona de estudio 

Para poder transformar la capa vectorial de la zona de estudio a una capa ráster es necesario 

utilizar la herramienta “Polygon To Raster”, que se encuentra en la caja de herramientas 

(ArcToolbox), concretamente, en el grupo de comandos de herramientas de conversión. 

 Conversion Tools → To Raster → Polygon To Raster 

En esta herramienta, solo es necesario indicar la capa de entrada, que en este caso es la capa 

vectorial de la zona de estudio donde se indican algunas construcciones pertenecientes a la 

edad antigua, en concreto, del imperio romano. 
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Figura 67. Parámetros de la herramienta Polygon To Raster en ArcMap 

A continuación, se muestra una imagen con la capa ya transformada al formato ráster. 

 

Figura 68. Capa ráster de la zona de estudio 

IMPORTANTE: en el apartado “11.1.- CAPA VECTORIAL DE LA ZONA DE ESTUDIO” se 

explica como se ha obtenido la capa vectorial (capa_vectorial_zona_estudio) que ha sido 

utilizada como dato de entrada en este apartado. 
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5.7.4.- Mapa de superposición ponderada 

El mapa de superposición ponderada se puede obtener utilizando la herramienta “Weighted 

Overlay”, que se encuentra en la caja de herramientas (ArcToolbox), concretamente, en el grupo 

de módulos de herramientas para el análisis espacial.   . 

 Spatial Analyst Tools → Overlay → Weighted Overlay 

La función de esta herramienta en superponer varios rásteres y, para ello,  utiliza una escala de 

medición común y pondera cada uno de los rásteres según la importancia que se le ha dado. 

En este caso en concreto, se quiere superponer la capa de pendientes reclasificada, obtenida en 

el apartado 5.7.2, y la capa ráster de la zona de estudio, obtenida en el apartado 5.7.3. Al cargar 

estas capas, se selecciona que se muestre la variable “value” de la capa de pendientes 

reclasificada y la variable “nombre” de la capa ráster de la zona de estudio. 

Al ser muy importante la orografía del terreno a la hora de calcular la ruta de menor coste, se le 

ha dado una influencia del 70% a la capa de pendientes reclasificada y un influencia del 30% a la 

capa ráster de la zona de estudio. 

 

Figura 69. Parámetros de la herramienta Weighted Overlay en ArcMap 
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Como se puede apreciar en la imagen anterior, a cada una de las construcciones antiguas se les 

ha aplicado un peso de nueve 9, que es el peso máximo posible, para evitar que a la hora de 

calcular la ruta de menor coste el camino pase o transcurra a través de ninguna de estas 

construcciones. 

Acto seguido, se muestra una imagen con el mapa de superposición ponderada. 

 

Figura 70. Mapa de superposición ponderada 

5.7.5.- Mapa de distancia de coste 

El mapa de distancia de coste se puede obtener utilizando la herramienta “Cost Distance”, que 

se encuentra en la caja de herramientas (ArcToolbox), en concreto, en el grupo de comandos de 

herramientas para el análisis espacial. 

 Spatial Analyst Tools → Distance → Cost Distance 

Esta herramienta calcula la distancia de coste acumulativo desde el punto, puntos o entidades de 

partida más cercanas para cada una de las celdas que componen la zona de estudio. Para ello, 

necesita varias capas de entrada que indiquen la región a analizar.  

 Input ráster or feature source data: es un dataset ráster o de entidades que identifica el 

lugar (celda o celdas) desde el que se calcula la distancia de coste mínimo acumulado. 

En este caso, es una capa vectorial en formato .shp que contiene el punto inicial de la 

ruta que se calculará más adelante. 

 Input cos raster: es un ráster que indica el coste para moverse de forma planimétrica a 

través de cada celda que conforma el ráster de la zona de estudio. En este caso, es la 

capa ráster que contiene el mapa de superposición ponderada obtenido en el apartado 

5.7.4. 
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Figura 71. Parámetros de la herramienta Cost Distance en ArcMap 

A continuación, se muestra una imagen con el mapa de distancia de coste. 

 

Figura 72. Mapa de distancia de coste 

5.7.6.- Mapa de menor vínculo de coste 

El mapa de menor vínculo de coste se puede obtener utilizando la herramienta “Cost Back Link”, 

que se encuentra en la caja de herramientas (ArcToolbox), en concreto, en el grupo de 

comandos de herramientas para el análisis espacial. 

 Spatial Analyst Tools → Distance → Cost Back Link 

Este módulo, define e indica la siguiente celda en la ruta de menor coste, es decir va marcando 

las celdas vecinas por las que transcurrir entre ellas sea lo menos costoso posible. Para ello, 

necesita varias capas de entrada que indiquen la región a analizar y el punto de inicio.  
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 Input ráster or feature source data: es un dataset ráster o de entidades que identifica el 

lugar (celda o celdas) desde el que se calcula la distancia de coste mínimo acumulado. 

En este caso, es una capa vectorial en formato .shp que contiene el punto inicial de la 

ruta de menor coste que se calculará más adelante. 

 Input cos raster: es un ráster que indica el coste para moverse de forma planimétrica a 

través de cada celda que conforma el ráster de la zona de estudio. En este caso, es la 

capa ráster que contiene el mapa de superposición ponderada obtenido en el apartado 

5.7.4. 

 

Figura 73. Parámetros de la herramienta Cost Back Link en ArcMap 

Como se puede apreciar en la imagen anterior, los datos de entrada utilizados en este comando 

son los mismos que se han utilizado en el apartado anterior para calcular el mapa de coste de 

distancia. 

Ahora, se va a mostrar una imagen que contiene el mapa de menor vínculo de coste calculado. 
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Figura 74. Mapa de menor vínculo de coste 

5.7.7.- Ruta de menor coste 

La ruta de menor coste se puede obtener utilizando la herramienta “Cost Path”, que se encuentra 

en la caja de herramientas (ArcToolbox), concretamente, en el grupo de comandos de 

herramientas para el análisis espacial. 

 Spatial Analyst Tools → Distance → Cost Path 

Este módulo calcula la ruta de menor coste entre un punto origen y un punto destino. Para ello, 

necesita varias capas de entrada para que pueda analizar y definir la ruta de forma sencilla. 

 Input raster or feature destination data: es un dataset ráster o de identidades que indica 

la celda o celdas desde las que se determina la ruta de menor costo hasta la celda o 

celdas menos costosas, es decir, indica el punto o puntos finales de la ruta de menor 

coste. En este caso, es una capa vectorial en formato .shp que contiene un punto final 

de la ruta. 

 Input cost distance raster: es un ráster de coste de distancia que se emplea para 

determinar la ruta de menor coste desde el punto final hasta el punto inicial de la ruta. En 

este caso, es la capa de distancia de coste obtenida en el apartado 5.7.5. 

 Input cost backlink raster: es un ráster que determina el camino de menor coste para 

volver al punto inicial. En este caso, es la capa del vínculo de menor coste calculada en 

el apartado anterior. 
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Figura 75. Parámetros de la herramienta Cost Path en ArcMap 

 A continuación, se muestra una imagen con la ruta de menor coste sobre la capa ráster de la 

zona de estudio y el mapa de distancia de coste. 

 

Figura 76. Ruta de menor coste en ArcMap 

 

5.7.8.- Ruta de menor coste como polilínea 

La ruta de menor coste se puede transformar a una polilínea utilizando la herramienta “Raster to 

Polyline”, que se encuentra en la caja de herramientas (ArcToolbox), en concreto, en el grupo de 

comandos de herramientas de conversión. 

 Conversion Tools → From Raster → Rater to Polyline 
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Este complemento, como indica su nombre, transforma una capa en formato ráster a formato 

polilínea. Para ello, solo es necesario indicar la capa ráster de entrada que se quiere transformar, 

en este caso, la ruta de menor coste obtenida en el apartado anterior. 

 

Figura 77. Parámetros de la herramienta Raster to Polyline en ArcMap 

Ahora, se muestra una imagen con la ruta de menor coste como polilínea sobre la capa ráster de 

la zona de estudio y el mapa de distancia de coste. 

 

Figura 78. .Ruta de menor coste como polilínea en ArcMap 

Esta conversión se ha realizado para poder cargar la capa con el camino calculado en QGIS, 

porque en este software se realizará la cartografía del proyecto.  
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5.7.9.- ModelBuilder 

ModelBuilder es una aplicación de ArcMap que se emplea para 

crear, analizar y editar flujos de trabajo que contiene módulos de 

procesamiento y geoprocesamiento conectados entre sí. Esta 

herramienta suele utilizarse para agilizar, de una forma 

significativa,  el tiempo para la realización de los distintos 

procesos que se quieren llevar a cabo. 

En la figura 79, se indica con un recuadro rojo el logo del módulo 

MolderBuilder en ArcMap. 

En este proyecto, se ha utilizado la aplicación ModelBuilder para 

engrasar todos los procesos que se han llevado a cabo para 

obtener la ruta de menor coste. Para ello, se han introducido los 

datos de partida empleados, así como las distintas herramientas y el nombre de las capas que 

se quieren obtener con cada una de ellas. El resultado de la construcción del diagrama de flujo 

se muestra en la siguiente imagen. 

 

Figura 81. Model Builder 

En ModelBuilder, para diferenciar entre los datos entrada, los procesos o herramientas 

empleados y los resultados que se obtienen se utiliza una leyenda de diferentes colores (azul, 

amarillo y verde), que se puede observar en la imagen anterior, donde: 

 Azul: datos de entrada 

 Amarilla: módulos de la caja de herramientas de ArcMap 

 Verde: resultados obtenidos 

También es importante señalar que algunos de los resultados intermedios que se obtienen sirven 

de datos de entrada a otras herramientas.  

 

 

Figura 79. Logo de MoldeBuilder en 
ArcMap 

Figura 80. Modelo de trabajo de 
ModelBuilder en ArcMap 
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6.- RESULTADOS 
En este apartado, se van a mostrar los diferentes caminos que se han obtenido en los diversos 

programas (QGIS, SAGA, ArcMap) sobre la ortofoto de máxima calidad 

”PNOA_MA_OF_ETRS89_HU30_h50_0668”. Primero, se podrá observar la ruta de menor coste 

obtenida en QGIS. A continuación, se mostrarán los dos recorridos que se han calculado con el 

programa SAGA en SAGA y en QGIS, así como una imagen con los dos juntos para comprobar 

que el resultado sea el mismo. En tercer lugar, se podrá ver el camino de menor coste obtenido 

en ArcMap. Y, por último, una ilustración con todas las rutas de menor coste. 

 

Figura 82. Ruta de menor coste en QGIS sobre una ortofoto 
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Figura 83. Ruta de menor coste de SAGA en QGIS sobre una ortofoto 

 

 

Figura 84. Ruta de menor coste en SAGA 
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Figura 85. Rutas de menor coste en SAGA y de SAGA en QGIS sobre ortofoto 

Al observar la  ilustración 78, se puede apreciar que las rutas de menor coste calculadas con el 

software SAGA en QGIS y en el propio SAGA son idénticas. Para poder ver esta coincidencia, 

de una forma clara, en la misma imagen, se ha utilizado una leyenda distinta para cada uno de 

los caminos, mostrando en color negro la ruta obtenida en SAGA y en color amarillo el recorrido 

calculado en QGIS con las herramientas de SAGA. 

 

Figura 86. Ruta de menor coste en ArcMap sobre ortofoto 
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Figura 87. Rutas de menor coste sobre ortofoto 

En la imagen anterior, se muestra en color azul el camino obtenido en QGIS, en naranja el 

recorrido calculado en SAGA y en rojo la ruta de menor coste en ArcMap. Además, aparecen 

varios polígonos negros que representan algunas construcciones de la época romana.  

Dicho esto, se puede apreciar que la única ruta que no transcurre ni cruza ninguna de las 

construcciones es la calculada en ArcMap. 
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7.- PRESUPUESTO 
A la hora de realizar el presupuesto de un proyecto, hay que tener en cuenta todas las variables 

que han sido utilizadas en él. Esto quiere decir, que hay que considerar, por una parte, la parte 

económica necesaria para la adquisición de los datos y los softwares necesarios para su 

correcto uso y, por otra parte, el sueldo a pagar del técnico que ha realizado el trabajo en 

gabinete. 

Como se ha nombrado en puntos anteriores, los datos de partida utilizados se han obtenido del 

Centro de Descargas del Centro Nacional de Información Geográfica (CNIG) y, por tanto, su 

adquisición ha sido gratuita y no supone ningún coste para el proyecto. Además, los programas 

informáticos empleados para el tratamiento de los datos (LAStools, Fusion, QGIS, Saga y 

ArcMap) se pueden descargar de forma gratuita en sus portales web, excepto ArcGis (ArcMap) 

que necesita una licencia de pago para poder ser utilizado, por lo que se ha tenido que hacer un 

desembolso económico por uno de ellos. 

Por tanto, para saber el coste económico necesario para este proyecto, solamente hay que tener 

en cuenta el tiempo empleado por el técnico para la realización del trabajo, la parte proporcional 

del coste de la licencia del producto ArcGis, los gastos generales y el beneficio que quisiera 

obtener la empresa por dicho trabajo. 

Todo proyecto, a la hora de calcular su presupuesto, tiene una parte de costes directos, que en 

este caso son el salario a pagar al trabajador y la parte proporcional de la licencia de ArcGis 

Desktop, una parte de costes indirectos, que son los gastos generales, y el beneficio industrial.  

El salario de un ingeniero en geomática y topografía se ha obtenido del convenio de trabajo del 

sector de Oficinas y Despachos de Valencia del 2019, donde se indica que un trabajador con 

este nivel de estudios pertenece al nivel II (Titulado Medio o Diplomado). En este mismo 

convenio, se indica que el sueldo anual del trabajador es de 14 pagas, 12 por cada uno de los 

meses del año y dos pagas extraordinarias (Junio y Diciembre), hay un plus por convenio y el 

número de horas anuales a trabajar asciende a 1767.  

Para saber el coste que tiene la empresa respecto a su trabajador, es necesario saber la parte 

proporcional de gasto por día de trabajo. Para ello, se calcula, en primer, lugar, el salario bruto 

anual de trabajador, que será el salario mensual y el plus por convenio multiplicado por las 

catorce pagas y el pago a la seguridad social que tiene que afrontar el empresario por su 

empleado. 

SALARIO BRUTO MENSUAL: 1427,13 € 

PLUS POR CONVENIO MNESUAL: 67,73 € 

SALARIO BRUTO MESUAL TOTAL: 1427,13 € + 67,73 = 1494,86 € 

SALARIO BRUTO ANUAL: 1494,86 € × 14 = 20928,04 € 
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Además del salario bruto del trabajador, es necesario saber la parte proporcional que se debe 

pagar a la seguridad social por él, que aproximadamente es el 40% del sueldo, quedando el 

gasto anual de la siguiente manera: 

GASTO ANUAL POR TRABAJADOR: 20928,04 € + 8371,216 € = 29299,56 € 

Sabiendo el salario bruto anual de trabajador y el número de horas trabajadas a lo largo del año, 

se puede calcular el sueldo por hora del empleado. 

SALARIO/HORA: 29299,56 ÷ 1767 = 16,58 €/ℎ 

 

Tabla 1. Convenio de trabajo del sector de Oficinas y Despachos de Valencia del 2019 
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La realización de este proyecto ha durado 5 días hábiles, por lo que el coste total relacionado 

con el salario del trabajador es el siguiente: 

DURACION PROYECTO: 5 días 

HORAS TOTALES: 5 días × 8h/día = 40 horas   

COSTE TOTAL TRABAJADOR: 40 horas × 16,58 €/hora = 663,20 € 

En este proyecto, se ha utilizado la licencia avanzada de ArcGIS Desktop con todas sus 

extensiones teniendo un coste anual de 6000 dólares, en Estados Unidos, que equivale a 

5070,39 €. 

 

Figura 88. Coste licencias ArcGIS Desktop en EEUU 

El tiempo empleado con este software ha sido de dos días de trabajo, que se traduce en 16 

horas. Para saber la parte proporcional de la licencia en esos dos días, es necesario cuantos 

días de trabajo hay a lo largo de un año y, una vez conocido esto, se puede obtener el coste del 

producto por cada día.  

Estableciendo una jornada laboral de 8 horas y con las 1767 horas de trabajo anuales se 

obtiene: 

DÍAS LABORALES: 1767 ÷ 8 = 220,875 ≈ 221 𝑑í𝑎𝑠  

Quedando el precio de la licencia por día: 

COSTE LICENCIA POR DÍA: 5070,39 ÷ 221 = 22,95 €/𝑑í𝑎 

Sabiendo todo esto, se puede calcular el coste de la licencia de ArcGIS Desktopen este 

proyecto: 

COSTE ARCGIS DESKTOP: 22,95 × 2 = 45,90 € 

El coste directo de este proyecto se adquiere sumando el COSTE TOTAL TRABAJADOR y el 

COSTE ARCGIS DESKTOP. 

COSTE DIRECTO 

COSTE TRABAJADOR 663,20 € 

COSTE ARCGIS DESKTOP 45,90 € 

TOTAL 709,10 € 
Tabla 2. Coste directo del presupuesto 
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Los costes indirectos se engloban dentro de los llamados “Gastos Generales”, que, según, son 

entre el 13 y el 17 por ciento de los costes directos. En este proyecto se ha considerado un 15 % 

los Gastos Generales, por lo que los costes indirectos ascienden a: 

GASTOS GENERALES: 709,20 × 0,15 = 106,37 € 

 COSTE INDIRECTO 

GASTOS GENERALES 106,37 € 

TOTAL 106,37 € 
Tabla 3. Coste directo del presupuesto 

El beneficio de la empresa en el proyecto es del 10 % respecto a los costes directos, siendo este 

beneficio el siguiente: 

BENEFICIO EMPRESA: 709,20 × 0,10 = 70,92 €  

Ahora, sabiendo los costes directos, los costes indirectos y el beneficio de la empresa, se calcula 

el presupuesto total del proyecto. Es importante tener en cuenta el IVA, que es ente caso es del 

21 %. 

PRESUPUESTO 

COSTES DIRECTOS 709,10 € 

COSTES INDIRECTOS 106,37 € 

BENEFICIO EMPRESA 70,92 € 

IVA (21 %) 186,14 € 

TOTAL  1072,53 € 
Tabla 4. Presupuesto total del  proyecto 

El presupuesto total de este proyecto asciende a un valor de 𝟏𝟎𝟕𝟐, 𝟓𝟑 € 
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8.- CONCLUSIONES 
A través de este proyecto se ha visto como obtener un modelo digital del terreno (MDT) o modelo 

digital de elevaciones (MDE) a partir de nubes de puntos LIDAR, mediante una serie de 

operaciones, las cuales se ha intentado que sean las más rigurosas posible para tener el mejor 

resultado. 

A partir del MDT, se han 

calculado varias rutas 

alternativas, empleando 

diferentes softwares, dando 

diferentes resultados, que se 

muestran en la imagen de la 

izquierda, que es la misma 

que la imagen 81 del apartado 

6. 

De los tres caminos 

resultantes, se puede decir 

que el mejor o al que se 

puede considerar más exacto 

y riguroso es el obtenido en ArcMap (en la imagen anterior aparece en color rojo), ya que es el 

único que no atraviesa el circo romano. Esto es entendible debido a que en ArcMap se han 

empleado más herramientas que permitían poner mayores restricciones a la hora de calcular la 

ruta, como el mapa de superposición ponderada, donde se podía utilizar pesos y se ha aplicado 

una influencia del 70% para la topografía del terreno y un 30 % a las construcciones existentes 

en la época romana; estos niveles de influencia se han marcado así, porque se quiere y quería 

que la parte más importante a la hora de hacer los procesos fuese la orografía del terreno, por lo 

que se le ha aplicado un peso superior que al resto de elementos. También se ha calculado, en 

ArcMap, un mapa de distancia de coste y otro que indica el vínculo de menor coste entre los 

píxeles adyacentes. 

Dicho esto, otra forma de 

comprobar que la ruta obtenida 

en ArcMap pueda considerarse 

correcta es analizarla junto a 

las curvas de nivel de la zona 

de estudio, las cuales se 

muestran en la imagen de la 

derecha. 

Se puede observar que la 

parte final del camino 

transcurre por una zona donde 

el relieve del terreno tiene una 

Figura 89. Rutas de menor coste sobre ortofoto 

Figura 90. Curvas de nivel de la zona de estudio 
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pendiente considerable, ya que las curvas de nivel se encuentran muy juntas entre sí y, estas, se 

han calculado con una distancia de 10 metros entre ellas. Esto, puede indicar que el acceso al 

castillo sea complicado debido a lo abrupto del terreno de la zona, pero podría haber sido un 

punto a favor, en la época romana, para la mejor defensa del castillo. 

Por otra parte, podría mejorarse, bajo mi punto de vista, la obtención de la ruta de menor coste 

entre el puente del río Palancia y el castillo empleando las curvas de nivel dentro del proceso de 

cálculo o poniendo mayores restricciones, como que el valor de la pendiente no pueda superar 

un valor límite, marcado previamente. 

A pesar de la problemática que nos podemos encontrar en el tramo final del recorrido, se puede 

considerar que los resultados obtenidos pueden satisfacer el objetivo principal de este proyecto, 

ya que se ha conseguido obtener una ruta, lo más exacta y rigurosa posible, en la que se ha 

tenido en cuenta muchas variables diferentes, como la topografía del terreno y las 

construcciones preexistentes. 

Para finalizar, este trabajo ha servido para poner en práctica conocimientos que se han adquirido 

a lo largo de la carrera y para poder familiarizarse con los programas FUSION, QGIS, ARCGIS, 

los cuales también se habían empleado en varios cursos durante el grado, y SAGA, que no 

había tenido la oportunidad de poder trabajar con él y es un software potente y sencillo de 

utilizar. 
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10.- ANEJOS 

10.1.- CAPA VECTORIAL DE LA ZONA DE ESTUDIO 

Para la obtención de la “capa_vectorial_zona_estudio”, se han realizado una serie de pasos, los 

cuales se van a explicar, de una forma clara y concisa, a continuación.  

En primer lugar, desde el programa de ordenador QGIS, se crea un polígono cuya extensión es 

la misma que la zona de estudio y análisis de este proyecto. Además, se digitaliza, en otra capa, 

varias construcciones romanas, las cuales se han obtenido gracias a la bibliografía aportada por 

la directora del castillo de Sagunto. 

Es importante decir, que estas dos capas has sido creadas como datos vectoriales. 

 

 

 

 

 

Una vez creadas las dos capas anteriores, se utiliza la herramienta “Diferencia” para obtener una 

capa con la extensión de la zona de estudio, pero sin el espacio que ocupan la construcciones 

romanas. Este módulo se encuentra dentro del grupo de procesos “Vectorial”. 

 Vectorial → Herramientas de geoproceso → Diferencia 

Figura 92. Polígono zona de estudio Figura 91. Construcciones romanas 
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Figura 93. Parámetros de la herramienta "Diferencia" en QGIS 

El resultado de esta operación se muestra en la siguiente imagen. 

 

Figura 94. Zona estudio sin construcciones 

Ahora, en ArcMap, se pretende juntar la capa obtenida anteriormente 

(zona_estudio_sin_construcciones) con la capa de construcciones romanas 

(construcciones_Antiguas). Para ello, se usa la herramienta “Merge”, que se encuentra dentro de 

grupo “geoprocessing”. 

 Geoprocessing → Merge 



Página | 66  
 

 

Figura 95. Parámetros herramienta "Merge" en ArcMap 

Por último, se van a mostrar dos imágenes, una con la capa resultante de esta operación y otra 

con la tabla de atributos de dicha capa.  

 

        

 

 

10.2.- CARTOGRAFÍA 

  

Figura 97. “capa_vectorial_zona_estudio” en ArcMap 

Figura 96. Tabla de atributos de 
"capa_vectorial_zona_estudio" 
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FUSION 

 • MergeData 
• ClipData 
• GroundFilter 
• GridSurfaceCreate 
• DTM2ASCII 

 

QGIS 

 • Slope 
• Least Cost Path 

SAGA 

 • Slope, Apect, Curvature 
• Accumulated Cost 
• Least Cost Paths 

ARCMAP 

 • Slope 
• Reclassify 
• Polygon To Raster 
• Weighted Overlay 
• Cost Distance 
• Cost Back Link 
• Cost Path 

En la actualidad, los datos LIDAR tiene un gran uso en el 
mundo de la topografía. En este proyecto, se usan varias 
nubes de puntos LIDAR junto a herramientas de varios 
softwares para determinar la mejor ruta entre el puente 
del río Palancia y el castillo de Sagunto. 

 

Tras la realización del proyecto, el mejor software  para 
el cálculo de ruta de menor coste es ArcMap, que es 
lógico debido a que se pueden realizar más 
restricciones que en el resto de programas. Dicho esto, 
se puede decir que resultado final obtenido puede 
considerarse bueno, ya que satisface el objetivo 
propuesto en el proyecto. TR
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